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6-1 BRIRIE LPCXpresso DAF

@ LPCXpresso [d. CodeRed (Rsedd URL) h'6AF D YO—-—RUET, IO VDO—RICIEA-—T &%
MUBICZNDZET)
http://locxpresso.code-red-tech.com/LLPCXpresso/

@ WEBAXR—=Y#ZER &, OF 1 vBEEMENE T, LPCXpresso DA—H—ANHD Y b ERFHH TERNBES
(& Create Acount] M Y& D L TPADY FZEERLTLIIZE0N,
BCPHDY RERFBHOHIE. R=—IYELINA—H—-8E/XAD—REAHDLT ILOG INJ &OU)
w2 LT,

‘ username LOGIN CREATE ACCOUNT FORGOT PASSWORD? SEARCH

I I ™
~
PROY R le_red
—
~
HNIEDTr>v LT
s -
LPCXpresso powered by Code Red —
LPCXpresso is a full featured low cost development system for the LPC microcontrollers from NXP.
The LPCXpresso IDE is svailsble for Windows and Linux hosts. See the Getting Started Guide (PDF) for full details on system
requirements to run the LPCXpresso IDE.
Register here to create an account and download and activate your copy of the LPCXpresso
development tools:
| Create Account <
~
PRIV D !

FONISHTARIER
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http://lpcxpresso.code-red-tech.com/LPCXpresso/

@ PADYFDOEXTIE. MROXIBEBZADLTIZSU,

Create Your LPCXpresso Account
YOUR INFORMATION

First Name* 280

Last Mame* BF

Address® X BN U BEDIEFR
City* BN

State/Region® BARS Japan EA
PostaliZip Code* HEES

Telephone® EEBS

Organization Name® PAIBUCV\DIEE., FREBLE
Job Title ADUBELSTEOK
End application market ADUBELSTEOK
(consumer, industrial control, automative, etc)

YOUR LPCXpresso ACCOUNT FEN1I-Y—-8
Username® (PIVT PRy F+HFT)
Email* X—=)LPRUR
Email (repeat)* X—=)V7 U RH#SRA

ADDRD 2518 T

@ TSign Up] &BITE, UMTDEDICRIASIN. ABDULCKAX—ILP RUZBICA =)L BEET,

Home

An email containing your login information has been sent to:

@
We have processed your details and an email with a tempaorary password has been sent to your
email address.
Important: IMPORTANT: Please ensure you can receive emails from Ipcxpresso@code-
red-tech.com. If you do not receive your email within 1 hour, please check your spam folder
andfor check with your system adminstrator to see ifthe email has been blocked. If you cannot
receive email from this account, you will not be able to login.
Login and change your password to a permanent one. You will also be able to download
LPCXpresso and register for your activation code.

Thank you for registering.

14



B UTDEOIBX—ILDEE. ERUCIA—Y—BOTIC/NRD— RORHNTNEII DT, ZN&FA
LC@QonBaNS0T 1> L TLIZEb),

Thank vou for registering LPCXpresso. You can now go to the Code Red Technologies LPCXpresso site and log in using
the following username and password:

USEMame.  sgddkiss

password:  sesksesdddw :g)j_._-lj‘._gt/lej_ |:

) ~
After logging in, we advise you to modify y _CDD‘{ V9D yunt link on the left navigation bar. You
will also have access to the user space that allow vou to download the LPCXpresso software and register for an
activation code.

Code Red LPCXpresso team
This is an unattended mailbox. For support or other questions on LPCXpresso, visit http://www.nxp.com
[lpcxpresso-forum

® OJ1>viLies, XR=IhRo 1 .Donwload the LPCXpresso installer for your host by clicking
here] O RICHD MDownloadl MAYY&ED w2 LT EE0)N,

Welcome I A—H—EhERENITT.

The LPCkpresso IDE is available for Windows (Windows XP, Windows Vista and V
Guide [POF) for full details on system requirements to run the LPCXpresso IDE.

If you hawve not yet installed LPCXpresso, follow these steps to download, install 5

4

. Download the LPCXpresso installer for your host by didking here:

Downloads |

DUwD

15



@ D)y DFTRER=IDBPODENDDT, ZONR—IH5 LPCXpresso for Windows] 20w L
T<rEEL,

*Linax MiRCEBFEATEETI H. A CPU N— RI3 Windwos IRIEBDOHDXT I E S TUVEZVDNTH
NZFET,

Home
LPCHpresso is available for Windows and Linux hosts. Clidk the links below to f

P . LTH g
m LPCHpresso for Windows

m LPCxpresso for Linux QIJ \yg

DIwDFTBDEREBDOR=IICHPOEBENDDFIT, CORXR—=—IDRFEKD NNLPCXpresso v?.2.?
[Current stable releasel] WD UYDOZD) v O LTLIZEV, (UYDDXIXFEINEII I DT PD
N—=I3EaKRLEI)

D)y DIBDEFIYO—RMBFEDTT, T71ILDOY A IIEREICKENCH. FOV0—RIC 1 65
BRZENDDHZBENHDFXIDT. TEFRLES,

LEmwW I Nl Fisnmiesns e

If you are having problems downloading, try this link to download via FTP:

LPCxpresso w2.5.8 [Cument stable release]
LPCHpresso v3. 5.0 [Pravious releass]
5till having problems? Ty the LPCXpresso support forum

DUy HLTYIYO—R |
Attachment Size
LPCHpresso w3.5.8 [Cument stable release] 167.52 MB
LPCxpresso v2.5.0 [Build 208] 156.28 MB
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6-2 LPCXpresso D1 > L—=)U

> 0— R U LPCXpresso Z PC [C1 VA~ —)LF DIFAIC DN TERBELE T,
SFOVO0—-FURAYRE=3 (exe 77 1)) ZFRTU. UMTRDFIRISOE>TA YA F—I)LEEDFT,
Fle. 1 YRAR=IVPICRY FDO=DICEMIDCENDDET, ZORIF. Ry FD—DEGFEHFI U THE
EaEDHTIZE0N,

XWindows D/N—=Y 3 VICK > T, HRDNEFTERDIBZENHDFT,

-EiEdl_lp =1
wr Welcome to the LPCXpresso
4\ Setup Wizard

This will install LPC¥pressa 3.5.6 [Build 234] on wour camputer,

It is recommended that you close all other applications before
PR ES SO conkinuing.

Click Mext to continue, or Cancel o exit Setup,

License Agreement
Flease read the Following important information before continuing,

Powered by
r_.code_red

Flease read the Following License Agreement, You must accept the terms of this
agreement before continuing with the installation.

LCB'I CODE RED TECHNOLOGIES, LINITED f’

hibtp: /fvavo nip, com/lpcxpresso

End-User Licence Agreement for LP CXpresso Software Development
NEXT Z#89 Toote
November 2009

THIZ END UZER LICENMCE AGREEMENT ("LICENCE") I3 A LEGAL
(AGREEMENT BEETWEEN YOU (EITHER & SINGLE INDIVIDUAL, OR
STHNCTE 1FEGAT. FNTITV AND CODFE RED TECHNOTOGIFES TIMITED T

¥ 1 accept the agreement; Pt
...................................................... i |
9: ITwv { 7?5 = Idonot accept the agresment

WG 2

http:f s, o, comflpexpresso < Back I Mext > I Cancel |

Falder

9 The folder NEXT Zi89

C¥nxp¥lpoxprezzo 35

doezs not exist, Would vou like the folder to be created?

i [0, l"z {H} | -EiEef.up =L

Debug driver selection
Please select which drivers to install,

X\ ZIRT

‘Windows may issue warnings when installing these drivers.,
If prompted, please allow the drivers ko install,
Drivers are located in the "Drivers" directary of the installation

¥ ‘Code Red Debug drivers
[V WP LPC-Link drivers

YA 2

bkt S, iop. comylpcxpressa < Back I Mext = I Cancel

NEXT &89
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Select Start Menu Folder .
‘Wwhere should Setup place the program's shortcuts? o
Setup will create the program's shortcuts in the Following Start Menu Folder,
To continue, click Mext, If you would like to select a different Folder, click Browse,
Browse... |
Select Additional Tasks .
WEIGIE, 234 ‘which additional tasks should be performed? s
bitkp: s rip, comflpexpresso < Back I pewt = I Cancel
Select the additional tasks you would like Setup ko perform while installing LPCxpressa,
then click Mesxt,
& For all users
' Far current user only
Ready to Install .
Setup is now ready to begin instaling LPCXpresso on your computer, i
3 G 2
Click. Install o continue with the installation, or click Back if you want o review or bkt S, nop. comylpcxpressa = Back I Mext = I Cancel
change any settings. — —
Destination location: -
Ci¥nxp¥lpcxpresso_3.5 N EXT E;$ g,
Start Menu folder:
LPC¥presso w3.5
Additional kasks:
Additional icons:
Create a desktop icon
Far all users
Install drivers: :
Code Red Debug drivers - Installing A
LI » Flease wait while Setup installs LPC¥presso an your computer,
G 2
< Back Install Cancel | Extracting files...
C:¥nxp¥lpcxpresso_3.S¥eclipse¥ijre¥bin¥igs. exe

bbb e, meep. comylpcxpressa

Install Z# 9

AT bmﬂlﬁﬁﬂ‘ﬁkhﬂtﬂ\ AT h
o] PR S e Sy

E
EPHTL. VIR F A0 SR LT
FAMSHBLEVIFITPEAFIBCEE.

Microsoft (I5E{ 1&% LETs

A A= EEITLES
HrEECEDRY. X
dd. ST l‘
Windows 0102

(|

FELETHD

A5 2

http vy, mip. comylpcxpressa

SENMERTSNBCED DD

TN BEHDIEADT.
INT [HfT) 28 LT,
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Completing the LPCXpresso Setup
Wizard

Setup has finished installing LPCXpresso on your computer,
The application may be launched by selecting the installed
icons.

PRESSO

Click. Finish to exit Setup,

V| LPCXpresso Getting Started

Powered by
r—_-code_red

btk fan, rip, com/lpcxpressa

< Back I Einish |

M ET. LPCXpresso D1 VA +—=)UIZ5RT T,

19

Information
Please read the following important information before continuing,

PRESSD

‘When you are ready to continue with Setup, click Next,

[ PCxpresso (powered by Code Red Technologies)

Release Notes

(Linuzx - all includes updates as for latest Windows release)
v3.7.6

- Picked up all latest Windows fixes and updates

v3.7.5
- Picked up all latest Windows fixes and updates

v3.7.4
- Fixed more problems with Mew Project wizard

v3.7.3
- Fizxed header files For newlib, Both newlib and redlib can now be used. LI
Y3 GG e
bt fvwe, nixp. comflpexpresso

Mext = I

NEXT 189

Finish &89 &,
LPCXpresso h't&) LE T,



6-3 LPCXpresso D#cE) & 505E

RIC, UFOFIEICTE > T SWEHFRZITNE T, seFECTIEA YA E—)LURE PC Z+1 V5 —R vy ~TE:

I d. FEE 1YY=y FCE#HL TS PCOMEICZDBHDET,

@ FF. LPCXpresso Zfg) UFE T, BENIDICIE. TRO YT EOPAIVESTIVD V) W DT BH\.
A= AZ2—OIANTOTOTSAKD TLPCXpresso vxx] > ILPCXpresso vix] &2 )w 2
LTLEEW, GeklZIEr YR =)L UTZ LPCXpresso M/N—I 3 YDHFTANDZET)

@ BIFIDEUTOBEINRRISNET,

\ ¥ 4
A .
PRESSO
Powered by @code_red
EENNEERERENR

@ WAZTOTCVWVBENEMUTDRIBRAINSNEIDT, OK ZIBLET.

Licenze type: UNREGISTERED (Code=13
!E Debue limit: 8k
Activation code: not available

To request an activation code or to activate a licenze, pleaze select
Help—>Product Activation

Licenze Restriction:

fn UMREGISTERED copy of LPCHpresso may only be used for
evaluation purpozes.

Register and activate to remove this restriction.

20
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@ HEEFIDE. UNOREBEARTZSNET,

Run

Windon  Help

[ i Jg-E- 2/ % |CSEH uCBOLLe [ lew|%| Ja-le |5 £i| A Develon
[ . o
[ Project Ex 52 it Gore Regis | = Peripheral | = O |[ G Weloome £3 =g
=l 8 & [l /O mp pcxpresss 35/pages umvegisteredhim =&
bV 4
PRESSO
VA N

An unactivate

Activating your product

() Quiskstart 53 . (9= Variables | % Braskpoints| = O
o Start here =
& New project.
@ Import Example project(s)
0 Build all projests
& Buid ' [
& Clean " L
3 Debue " [

Please note: Your product is not activated

duct may only be used for Evaluation purposes. Register and activate your product to remove this restriction

powered by EIcode,red

= Gonsale 53 |2 Prablems | (J Memory | {8 Red Trace Preview|

(2 Quick Settings ~

~. Project and File mizards

J Ho consoles to display ot this time.

|

*. Import and Export

« o« o«

*. Build and Settines

[ R-JtETENELE

B W=)UN=DANILTH 5,
F9,

J J norkspace

Help >Product activation > Create Serial number and Activate... Z&

indow | Help

€ oG {7) Help Gontents
@5"' Search
Dvnamic Help

w

|
sl

kew dezist. Ctrl+3hift+L

Tipz and Tricks..
Cheat Sheets..

Product activ
SLppart

Inztall Mew Software...

| | /A - | %

presso 00/ pagesunregisterad him

FE<

" Digplay licenze type..

Pl

Enter fctivation code

About LPCHEpresso

3 |dperade your product

S |

I

® RASNLEIYIPIVTIYN=ZEXE, JE-FTDIBELT. —BHICREFELTRE, OK 2B LI,

Create Serial number and Activate

Select O to vizit the regiztration webzite where vou can
regizter vour product and receive an Activation Code.

]|

PRESSCY

JUPIVFTIN—ZAXELUTREET,

Serial number I\ EE R ok I R e L S R S SR S R O R O I L R S T R S L L

[T Open in external brovwser

¥ Copy Serial Humber to clipboard:

FzvOUET

Cancel |

21
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@ OKZ®I &, UTFOOT+ YBENBEEET, 1 YRAF—3&5DY0—- R UEKRICERULCPADY
FOd—Y—-8. NRDO—FZ2ABDL. OTJ1YULET,
(OT4 VEHDEBES., ODBENREIEINT, @, GRIRIEILET.)

A—Y—-&, NRDT—READ

username .OGIN CREATE ACCOUNT FORGOT PASSWOR
e ——— e—

Home [ : My Registrations : | Blog : SupportKnowledgebase : Downloads

Home My Registrations Blog Support Knowledgebas Downloads
d d TM 9 /
My account Home
Log out .
My Registrations JUPITFTIIN-ZEAD
Enter serial number hars

I. Sk e dkedrk okt ook okt ook ki ok ek

| "~ send mgmy_act;atiu_n code ]

Send me my activation code &9

22



M VEBTE, UMTROEIDICRRIIN. PHIY REERUIZX—ILP RURIC lactivation code.
DEE SN E X—)LH BEFET,

My Registrations Bllil‘l Support Knowledgebase Downloads

@code red | 5 s

Home

My account
Log out
Your activation code has been sent to the email address for this account

{ XXXXXXXXXX@YYYyy .com).

Please ensure you can receive emails from Ipcxpresso@code-redtech.com, and check your
spam folder, in case you dont receive your code

Thank you for registering LFCXpressa.
Return to Home FPage or Register another product.

@) Help>Product activation >Enter Activation code =2 J) w2 U, POF«X—Y 3>V 30— RADE
BZEBE=ET,

't Search
|| Dynamic Help
e kKey feszist. Cir +5hift+L
1=’=f> T ce) Trids preszo 36/ pages/unregistered htm
Cheat Sheets..

Product activation " Display license type.. <
Support ¥ . Create Serial number and Activate..
Install Mew Software... - Enter Activation code

About LPCHpresso 3 Uperade wour product S

I

1 E X—=)UICEeEDH D lactivation code] ZAHDULET,
=

Enter Activation code

fctivate vour product by entering your Activation Code PRESS()

Activation code I‘k‘k‘k‘k_**‘k‘k_***‘k_***‘k_****_****_****_**%* |

E X—)UTREL\Z
activation code ZA NI D

(0] 4 I Cancel |

OK Zi8d
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M FEINERICTTIDE. MFOEDICRRAIN. FIRHNEEFSINE T, OK =B LE T,
]|

- Licenze tvpe: FULL

Debug limit: 128k
Brtivation Code: % s -dededede _dededesde e sente Lo ok e L e e e e e e e

& FULL copy of LPCHpresso may be uzed for production.

OK Z1#89

IM ET. LPCXpresso DREHEEIIST T T,

24



6-4 YVIILTJOIT I DA IYR—-FEEILE

WKWK CEBYYITINTOTSAZEFHHAH. CPUNEZAHET, CCCTERIDTYTIILITOTS
LI BEEREETOLCRREDTOIY D FEMTY Y IV ERH L TNEIDT. MUY IILTOYT I ]
EWUVFET, MFOFIBICE>T,. UYTILTOI D DA UR—~EEILREZET >TSS,

(1) D=DAR=D A IWITDEE

LPCXpresso &1 VA —)LURRKRIC. UTRDBAAICIEEDD =D INR=AMESNFE T, COEE, 1
—T-BCEABNF (BFRERLE) HE3INdHEE. ERBICEILFTEFZEBADT, D—DANR=T %)
SFNEBZET>TIREEL),

- WindowsXP D&
C¥Documents and Settings¥[1 —1'—&X%1¥My Documents¥lpcxpresso_3.5¥workspace
- Windows 7 DI&
C¥Users¥[1—t —&%]¥Documents¥lpocxpresso_3.5¥workspace
1 —Y =83 Windows ICOZJ1 Y L TCWNWB1—F—& T,

X EESRBANRSODSRNES. UMTFOFIRTI =D RR=R I A IIDEE =T >TIES0,

@ LPCXpresso DI 7 JULX_a—hH'5 Switch Workspace > Other...l] Z2RUD'J v D LET,

File Edit MNavieate 3Search Project Bun  Window Help

Mew Alt+Shift+h  » J =S 2C ET E
Open File,. . .
=
Ciloze Citr [+ heraq =N=k 0
Cloze All Citr [+Shift+
IES
Sawe Erl+s J
Have (..
Save Al Ctrl+Ehiftts
Revert
Mawe..
Fename.. F2
2| Refresh F&
Ciorwert Line Delimiters To 4
Erimt... Ztrl+f

Switch Wiorkspace

Restart

Switch Workspace > Other...

Tug Impart. . =
23 points |
zZ20Uvy D

7 Export..

Properties Alt+Enter

1 Welcame [Welcome paze]

Exit

I
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@ T[Brows...l 22w UZET,

!'#nrkspace Launcher x|

Select a workspace

LPCxpresso stores your projects in a folder called a workspace.
Chooze a workspace folder to use for this session.

Work zpace: |01¥Dncuments and Settings¥demo¥hy Documentz¥lpcxpreszo_3 b¥workspace ;I Browse.. |

» Copy Settings

Browse... 220 w2
@:l CK I Cancel I

@ ¥AIVEaA—FRD IA—RILT 1 RD(C)>nxpl T #ILIEERL. TFHUWNI 2 LI DR MY
VD )y D UET, fERSNE MHULWI 7Y 1 OEFIZE Tworkspace] I[CEELFET, OB,
HNIFFBRFTADLUTIIZSHN,

Select Workspace Directory 7] x|

Select the warkzpace directory to uze.

(& FADbe? -
SRSV
SR I W R
Bl Gee O—=HL T2 G

) AGENDA

) ARVEL

I Brother

I Documents and Settines

I My eBoaks
I My PageManager

- g by Skype Pishres— s Do LS ERIR
r|::-::|:| .
) Ipexpresso 35 21|

I OfficelUpdate orkzpace directary to use.
== PeCatin LI
pg N = —
: . e
LTS OUERR M) | ST D B s
——Ené O—hll T80 G
M7 LWL 2 LS DYERK 3 AGENDA

=g I ARVEL

|5 Brather
I Documents and Settings

I My eBacks
I My PageManager

[ My Skype Pictures
=25 nep

I lpoxprezzo_35

@} vork=pace

2z I)L5&IC : TP Mffieal Indate d

l'workspace] EF¥HATAD s [FRLLTLA

LT AOPERM | ok | wetn |

26




@ COFEFETIE. TAINAIDRMEINTUVZENDT, I A IS BICERE Tworkspacel EANT DD, MU
TOFIET., —ERIDIAIAIZED ) v D URREIC. BE Tworkspacel 22L& D v DL, D=

L&D Tworksoacel [C/8>TU\BZ EEER L. TOKI MY VEBLET,

Select Workspace Directory

21x]
Select the workspace directory to use.
=l s O-A) T02A0 G -]
I AGENDA
I ARVEL

I3 Brother

|3 Documents and Settings
I3 My eBooks

) My PaeeManager
) My Skype Pictres nxp D 7 LSRR
Bl 5 nep

H Ipcxpressn 25

B Off,,:e,_,date workspace 7 7 LY &EIR
I PeSetup

|3 Program Files

o (7= Razdma ;I

T A Iwurkspace workspace [C78 D CUV\DC E&TER

[ #rLe a0 | ok | Fetan |

Ve
OKJ MYV ZRT

Bworkspace 7 # LD TC¥nxp¥workspace] [CZ>TWBZEEER L. TOKI MYV =EIBLET,

-'lll'urkspac:e Launcher x|
Select a workspace

LPC¥pressn stores vour projects in a folder called a workspace
Chooze a workspace folder to uze for thiz zession.

Wiork zpace: IG:¥nxp¥wnrkspace

» Gopy Settings IC¥nxp¥workspace] ICE> TNBCEERES

©)

(] | Cancel |

OKJ RSV ZEBT

MET, D=DZAR=D# VI DEELTTTI,
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@QvYINTOID D1 VYR—
RICD=DIANR=R(CHYTINTOI D b+ UiR—FLET,

@ MT®D URL &D. VS-WRC103LV HBIR—EtXR=ICPOEIL. LED Y >Y7)ILJOYy 0~
N'VS-WRC103LV_Sample_LED_ xkkxk zip | Cekwk(3/N—T3>) ZHFDYO—FLULET,

http://www.vstone.co.jp/top/products/vs-wrc103lv

X UYR—R=ITRHELUTNDEDDERHICEDEIN. Ea—+O—/N—0D CD-ROM ZRHEDI5
&. CD-ROM A®D IC EFEBEB_ARM¥T Y TILTOY D B DA IRICE. @YY TILE@F LT
NET,

@ Zio D PAIEREUZ D ANASED—DZAR=AIDAIAICIE—UEI, 1) TIO—DZAR=2AT#)L
NEBEULERE. TC¥nxp¥workspace] [CJE—UET,

W=

| Zr0E REE RTW BRCADG w0
|OF2 -9 - | P8E o & X 7
JT"F"LJ\':Q:' 5 C¥rp¥work space j izgh

o

o E

.metadata import. log

Workspace 7 #JUVFIC. Zio 771 IVE&
BELUCTCERDAISFEIE—-TD

VEOATI O EER | PR 7

28


http://www.vstone.co.jp/top/products/vs-wrc103lv

@ LPCXpresso Zi2@ L. BEZL FDQuickstart Panel 1D lmport and Export] & D lNmport existing
projects] ZBE=E T,

llmport exisiting projects Zi#9
[:L Import files into "WS-WRC103LW sample_LED

‘EI Export projects to archive ‘zip!

‘EI Export projects and references to archive Gip)

Eug Smart Import wizard

Imiport estsiting projects
Salect & direchory 10 seanch for existing Eclipse progcts.

Browse Z##9

29



® YYIINTOI D REREFELURZ. D—DZAR=T# )L (C¥nxp¥workspace) &EIRL, OK &
BLET,

2|

Select root directory of the prajects to impart

& Faake? -
L =4 Bt
SR R e WG R
E = 0L T8 G

[3) AGENDA

I3 ARWEL

[5) Brother

| Dacuments and Settings

=) My eBooks

) My PageManager _ o .
|1 My Skype Pictures 0 92/\ A Z’)bgélg;R
B 155 nep
[ Ipoxpresso 35
[} orkspace

== M fieal lndata

[
o )L |w0rkspau:e OK &i8d
UL T EDPER M | ok | mevtn |

4

® AYR=FF2T0YTOk (CTTIE N'VS-WRC103LV_Sample_LED skttt stoksok | (okorok(FH
VIWDN=I3YVOEFHADET)) ZF Ty DL, lFinishl ZBLET,

ol

Import exisiting projects =
Select a directory to search for existing Eclipse projects. E ;

(+ Select root directory: |C¥nxp¥workspace

= Select archive file: | Browse.. |

Projecta:

----- VE-WRCT03LY Sample LED 20101207 1545 (G¥nxp¥workspac Select All |

A1 IMR—=+IR IOV REFTYVD Dezelect Al

Refrezh |

1| | 0

|v Copy projects into workspace

Finish Z#§9
@::l Einizh I Cancel |
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@ [Finish] Z20Jwv292%&E. BEAZLD MProject Ex) ICT7OY 0 ENENEY, CnTJ0ovy
I FDFHIAHEIFTTTI,
SIS LR L
KLr_‘, Project Ex &3 W Core Regis\l =, F‘eripheralw = Eq G

=
= ‘_5 EUS—'I.I'I.I'F{G'I 13V Sample_LED 20101207 1545
--qf;f‘ Binaries
+Y—0E@FETOVTY || F i) holudes Src DA LT
FAERBCENTEFT. B sre EEDY-—2T P IDBOET.

-|g| cr_startup_lpcl3c
lg| epio.c

c
lg| xbusc [
g mainc

- g we—wrc1 03
= Debug A
[& Releaze
[5; i
-2 lib

-~ : . - (==
V) Guickstart 23 (%)= Variables | g Breakpoints 8

o = . [ = | - (] e |

QU rIINTJayz O nEILR
RIC. TOTS L% CPUM—RICHRICERIDIEEDOLEIL FZEFTNET, UTOFIBICHK->T, EILE
Zi7oT<IEZSELN,
@ T[Project Ex] TEILRLEWVWTOY Pk (CCTTIE. VS-WRC103LV_Sample LED) ZEFEIR L.
Project>Build Projecrt 22w 2 L CE)L FZERIBLE T,

- Develop - Welcome page - LPCHpresso
File Edit Mavieate Search | Project Bun  Window Help

_ . (e Frajest
At . S = = -
J L= | ate J el Cloze Project J =
J = = - = :
- o Build All Cirl+B
I Praject Ex 3 aiet Gaore Build Configurations b [come E3
Build Project
Build Wark ing Set k U
= S Clean...
Eoys - Biriarics Build Automatically
el Theludes

EILETS 519 -~ Properties
JOYIU FERR |

|l cr_startup_lpcl3c
- Bl epioc
 Ebg] ixbusc

f R lel maine
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Q@ EBEILRZEREBIDEUTDI A POTHRRSINZINDT, TIIDETHHEI,
IIEuHmHEWMﬂEﬂa:E

@ FTTIBDE F1POTNEL. MFDXRIICKRRSNET.

Inwoking Gommand: arm-none—eabi-gcc —E.insfore eclipsecdt makecore/specsc

[ Blways run in backeround:

Fun in Backeround I

Cancel Detailz =»

|| # our products' zerial number will be displayed

=|

fE Conzole 3

[3_ Prublems} a Memnr'ﬂ " Red Trace F‘review}

L&l

& “|.=,:>-ETL=<_TT‘='E|\

C-Build [WS-WRC103LY Sample_LED 20101207 1545]

text
2753
text
2733

data
u}
data
o

h=s
430
h==
430

VS-WRC103LV Sample LED 20101207 1545.axf; arm-none-eabi-chjcopy -O binary
VS-WRC103LY Sample LED 20101207 1545.axf VS-WRC103LV Sample LED 20101207 1545.hin;
checksum VS-WRC103LV Sample LED 20101207 1545.hin;

dec hex f£ilensune

3243 cab VI-WEC103LV_ Sample LED 20101207 1545.axf
dec hex filename

3243 cab VS-WRCI03LV 3Jample LED 20101207 1545.axt

-l

4

J WE-WRCI03LY Sample LED { HXP [ PC1243

% CCTError BEEBE. 1) DD—=DZANR=2AT A )V DESN IERBICTATENWTREED BV FT,
BED—=DOZR=2ID A )V DEEETHO>TLIIEE),
GhLWDI )L DEEIEZEE T, Tworkspacel EANTBEEIFIUTFEBTADLUTLZELY)

X CEFBDY—RZiwEULEIC, Error EXRTSNIZHBEDOXITIEL 16-7 TS5 —DBIE] 2T

ét]\o
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6-5 VS-WRC103LV ADTOTSLADEE:AH

By TOYI D REEILETDE, D—DAR=RT ALY ¥ VS-WRC103LV_Sample_LED
¥ Debug AIC. N'VS-WRC103LV_Sample_LEDbin] EW\D D 7 ILAYWERRSNE T,

CDI7A)%&E CPUM—RICESZTADBE. ERLIETOTS A% CPUMN— RICETSEDICENTER
DT, UFOFIRT, SSRAHETo>TIES0),

USBZ —=J/ILEN L. CPUN—FOETNDERE OFF ICLET,

Ty amPVaBUIEEE. PCEUSBT —JILTERLET,

USBZ#&EmULIZS Ty Y amAVIEELTE OK T,

20 MRER/BDE, PCHCPUMN—RFZUSB XEUREELRU VAR U —=IF /N R EUTERH
LET., (T CPUNR—FZPC ICEIULHRS. @#EIC UIESBENDDDET,)

® oo

8 N

3) USB & U= 55@—9» 2) USBT =T ILERELIRAD

® CPUMR—EN PC ICER#IcNDE. TCRP DISABLE] EWSEBMOD RS+ TJ&TRRSNET, CPU
M—FZEEHUCS VI VEa—-F ] 28T COBMD RS A INRTSNDCEZERL. &
INDV)y D UTRSATEBEEET,
N—F T8 F347

S AL #0356

VL-RTNZEENELT A

.. DVD-RW 547 (D0 @ GRF DISABLD (E2

[

<
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©® [CRP DISABLEJ ZBE< &, BIC Tfirmwarebinl EWD I 7 1ILA—DA>TNEI DT, DD
71 ILEBIFRLUE T,

= CRP DISABLD (B

| HE REE BTV BROOE y-MD P

Q-0 -0 De= [T ||§ °

| PELAD f g =| £ 1z8h

o

Fir rmvare. bin
FOT4 Data File

32 KB

Elll R

@ D=DIAR=T#)LF ¥ VS-WRC103LV_Sample_LED ¥ Debug MM,
N'VS-WRC103LV_Sample_LED.binJ Z3E—LT. CRP DISABLE. RICR&D{HIFET,

& Debue 0] x|
| e REE FTW BROOE YLD AIE | P

Qm-© 3| Dws | =m2 |33 X °

| PEVAD) |5 1 3 5¥morkspace¥VS-WRG103LY Sample_LED¥Debue x| (£ 1580

=l

ve—wrc] 03k _Debug_mem.Id

 IN—
%DKS?FHL

= CRP DISAELD (B}

Ny WS-WRGT 03UV Sample_LED.axf

| A | FME REE RRW BRCAVE VLD >

J Q- 7 | POL - R | |- ?
R I]E:L"-.:"_Eia mple_LED bin

i 1ata File J?HL’A{E} I'-qﬂ E:x j #ﬁﬁj
YS=iRG] IRLW Samnle | EM man, % p

MAaP Pl
91 KB JE-93

fEDITD
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® PC D5 CPUM—RZERDAL, BESRZANDE. ESRAARLTOATSAICHK >TCPUR— RHE)
ELET, LED YT TOTSADESAHNERICT T LTNDE, ZL VY, #&D LED H3RZEIC
KRUTUE T,

‘0Q Q0 ©
0.0.0.0

©)

(©
0

o
D~ pas
33k

0’00

®
e)
(0 00
o Olo
0°©

C

MET, JOTSLDESAHFIRETTTI,
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6-6 LED®@MIOTSAICDNT

YTV LED R 700 S AR, BEELED(. Wait)’2EZEE>T LED ZHIfHLCWET., TN
BN YS D 7 1)U VS-WRC103LV.h R TEZESN. OIS ARTRBIDCENEEET,

LED RIB700 35 A0 main(BEHEURNICHUET, TOTSAZRITIDEE. TTFCD main() BEE
NHEERITEINZT, LED 70T S5 ATIE main(dledc RICHDFET,

1. void main(void)

2 {

3 //HIEBRBDRE (81 Hz & 30.07]
4. const unsigned short MainCycle = 60;

5

6. Init(MainCycle): //CPU D#EAFRTE
T //12C_init(void): //IXBUS #)H81t

8

o /=T

10: while(1){

11: LED(). //#&D LED RXT
12: Wait(1000);  //1000msec 5D
13 LED(2). //ZLYIDLED RKT
14: Wait(1000);  //1000msec 5D
15: }

16:  }

main BEEDETIC DUV TERBELE T,
O = (D)=
A4~T . SHEBEDREARTE
8 XA U)I—=T
while X TENNZERIL—TRICET LIz WEZESER LE T,
O~12 . {79 DB
LED(B8%E Wait () BEEZERIA L C LED ZRAEICRABSIE TNET,

ZREMICDONWTIEI AV Z2APILOSE FZEY Y TILT7OY D FROAYS I 741 )Ulvs-wrc103lv.h]
TEBEICHRELUTNEIDT, ZE5EELIIZE),

36



6-7 IS5—DELE

YYINLTAY O EDTOTSLEEE L, LRI DIEBXDOBENSETEIV RIS —NRETDICE
DHDET, Z0HE. MTOFIET, TS5 —DFREUCERZEER L. BELTIES0),

OTOTSACIS—DHorBE. IVY—IUCUTRORIDEE I RIEREHNARTIINFET,
Error DEOEUBEIZ. W DIS—D'HoEDZDENHNRISNZET,

Wait (1000); //1000mseci7F]

E Console 3 . &/ Problems} a Memorﬂ & S&arch} 8g Breakpoints} o Expressions\l 9= Variableﬂ 2o Call Hierarchy\l
C-Build [WS-WRC103LV_Sample_LED] FHE | = R b
arm-none-eabi-gce -D_ USE CMSIS=CMSISvilp30 LPC13xx -DNDEBUG -D_CODE RED -D REDLIB .|
-I"C:/Users/yokoyama S59/Documents/lpcxpresso_3.5/workspace/VS-WRC103LV_Sample LED/inc"

-I"C:/Users/vokovama S59/Documents/lpcxpresso 3.5/workspace/VS-WRCL03LV Sample LED/1ib" -00 -Os
-mword-relocations -g -Wall -c -fmessage-length=0 -fno-builtin -ffunction-sections -mcocpu=cortex-m3 -mthumb

-MMD -MP -MF"src/main.d" -MI"src/main.d" -o"src/main.o" "../src/main.c"

../e2rc/main.c: In function 'main':

wed 3Ee/main.ci22: prrorx: expected ';' before '"LED' |:| Fwo
make: *** [3rc/main.o] Error 1 | f
bl I
PC1343 B
S Ly I LIl « L TII L7 InIIl.id o oLy Inall

ILF L I
J'SIcfmain.c: In function 'main':
e fBreimadin. 22 arzori—expected™' IS-—0D#H | 'LED®

make: **%* [src/main.o] Error 1

QIS—DBZERIDLEHICIE. Problems] YT EEIR L. Errors ROWFNHDIS—&ESFT)ILD
Jw2D3ddE IT45LET. IS—EBRNRISINZET,
L1 A BB kxR R R R R

int main (wvoid)

/A RIENERADESTE (B vz FH: 30, 0~
const mnsigned short MainCycle = &0;
Init (MainCycle) ; f/cPul fEAERTE

£

while(l){

20 LED(1): f/FEDLED - — = -
21 Wait (1000) /. 3) IF«BICIS—EHRTEIND
22 5
25 Wait (1000); //1000mseciF i
24 H
25} &
4 F
&l Consold [[2 Problems &3 AMemory | 472 Search| ©- Rraaknaints | 1 Fxoressions | 69 riablesw 1% call Hierarchﬂ ¥ =0
2 errors, 27 Warmmgerd otvers 1 ) Problems E%;R
Description . Resource Path J~
) |
4 © Errors (2items) 2) Errors ADIEBZES IO U YD
| @ expected ;' before 'LED' , “103LV_Sample
@ make: *** [grc/main.o] Error 1 VS-WRC103LV_Sample_L...
a4 @& Warnings (27 items)
flash.h /BeautoRoverARM_firm _

& 'call_IAP' declared 'static' but never defined
L |

3

4 |

'C1343
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QT CTHIS—IE LEDR2):Daiom Wait(1000 )i T (2=230V) 1 HBRNCEICKDEDTIDT.
ZCEBIEUTBELEILFULET,

int main [(void)

J/RENE#AD R E (E iy 5z #EH:30.0~]

con=t on=igned short HMainCycle = &0;
Init (MainCycle); //ceul fT AR E

J=TF
while (1) {
LED (1) ; S AR LEDS LT
Wait (1000) s (rmeeid )
LED (2} :
Wait (1000) ; Hmr:-arrsecﬁﬁ

DIS—DE<BD, EBCEILFDRTTIREUTORSICRNSNET,

e R EoN |- R N

12int main (void)
134
/RN ERAD 58 (A 5z #E: s0.0~)

const onsigned short MainCycle = &0:

Init (MainCyele) ; / fceuD#EAER E
FA=2

19 while (1) {

20 LED(1) ; /A FRMLEDS T

21 Wait (1000); //1000mseciF)

22 LED(2) ; S LD LED S AT

23 Wait (1000); //1000mseci¥)|

24 }

25}

4

El Console 33 [ Problems} a Memorﬂ & Searchw Sg Breakpointﬂ & Expressions} 4= Variablesw T3 Call Hierarchﬂ
C-Build [VS-WRC103LV_Sample_ LED] @, Bx| ot

arm-none—eabi-objcopy -0 blnary V5- WRClD3LV Sample LED.axf V5-WRCLO3LV Sample LED bla checksum
V3-WRC103LV Sample LED.bin;

Cext data bss dec hex filename
2753 0 490 3243 cab VE-WRCLO03LV_ Sample LED.axf
cext data bss dec hex filename
2753 0 490 3243 cab V5-WRC103LV Sample LED.axf
| Smart Insert ‘ 23:33
201343

MET, IS5 —DEBIEEFTTTI, I7 1 FICKRT UCEICEET DB CHBMEC > TNDTREME
HOFIDT, ZORICEFRLTCIS—ZBIELT UL D,
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BZTY3 V=Y, BEBROCEAL - -
No1 dBHZ ! Ea—rO0-/N—-0FTY3Y, DRy ~ESERBOTHEARIFS

http://www.vstone.co.jp/robotshop/

TR, BEDSOMNY hEYSH—EETEONRY FEEBGRZEREVNKROVNEEITET,
ORy FEYY—RRUERIE (RRZIE) Oy bV —-0RRD TIPS (B/IES)

T101-0021 T814-0001
FRETFRBXINBE 1-9-O RBE)IL 4F ERhRERXEER 2-3-2
TEL : 03-3256-6676 TNC BUXA=E8E 2F OMRXO I PR
FAX : 03-3256-6686 TEL : 092-821-4111
BRI 8 10:30~20:.00 EEISR: 9:30~18:00
TB8% 10:830~19:00 EIRB:E 2 KIEB., FXREFWB

FRFWBEFS, FPREK

BB SEEnEhE

TEL: 06-4808-8701 FAX 06-4808-8702 E-mail infodesk@vstone.co.jp
SHFE 9.00~1800 (XBHMBIFF)

' ~ > .
DA ARVHRARH www.vstone.co.jp

T555—0012 ABrmheuie) | IXEHEBS 2-15-28
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